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Chapter 1. Setting up the tutorial

This chapter describes the tutorial setup. These requirements must be met before
you continue with the tutorial.

Software requirements

Ensure that the following are installed on your PC:

__ IBM WebSphere Transformation Extender with Launcher

__ IBM WebSphere Transformation Extender with Launcher Windows
__ IBM WebSphere Transformation Extender Trading Manager

_ Microsoft Access

Tutorial exercise files located in :
C:\install_dir\<tmgr_vn.n\tutorial
(where install_dir is the Trading Manager installation directory and n.n is the
Trading Manager version number)

The tutorial folder contains the following folders:
* data contains text (.txt), XML or database files

* maps contains IBM WebSphere Transformation Extender map source (.mms) and
map executable (.mmc) files

* trees contains IBM WebSphere Transformation Extender type tree (.mtt) files

* myfiles is the student working folder

© Copyright IBM Corp. 2006 1
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Chapter 2. Using Partner Manager

This chapter contains the following tutorials that are related to the use of Partner
Manager :

» |'Tutorial Exercise 1: Defining the Partner Manager Database’|

* |"Tutorial Exercise 2: Defining Trading Partners”

* |"Tutorial Exercise 3: Defining Post Offices”

* |'Tutorial Exercise 4: Defining Inbound Trade Links'|

» |'Tutorial Exercise 5: Creating Trade Link Type Trees'|

Tutorial exercise 1: defining the Partner Manager database

Trading Manager uses a relational database to store information about trading

partners, routing instructions, access privileges, document tracking and trading
relationships. A sample Microsoft Access database is included with the Partner
Manager installation.

In this exercise you will create an ODBC DataSource for the Trading Manager
sample database and define the database in Partner Manager.

The following file is required for this exercise:

tmgrnn.mdb
This is the sample Trading Manager database. You will find this file in:
C:\install_dir\<tmgr_vn.n>\pmgr

Note: Throughout this tutorial install_dir, is used to refer to the current install
directory of your IBM WebSphere Transformation Extender software and n.n
refers to the current version of Trading Manager.

Task: define the ODBC dataSource

Before you can define the sample database in Partner Manager, you must first
define a System Data Source Name (DSN) as described in the following
procedures:

1. From the Windows Start menu, select Settings > Control Panel >
Administrative Tools > Data Sources ODBC.

The ODBC Data Source Administrator dialog opens.

2. Select the System DSN tab, and then click the Add button.
The Create New Data Source dialog opens.

3. Select Microsoft Access Driver (*.mdb) from the list box, and then click Finish.
The ODBC Microsoft Access Setup dialog opens.

4. In the Data Source Name field, enter the following information:
CommerceManagerTutorial

5. Click Select.

The Select Database dialog opens.
6. Navigate to C:\install_dir\<tmgr_vn.n\pmgr and select the tmgrnn.mdb file.
7. Click OK.

© Copyright IBM Corp. 2006 3



The Select Database dialog closes. The new entry, TradingManagerTutorial, is
now displayed in the ODBC Data Source Administration dialog in the System
Data Sources list box.

8. Click OK.

The ODBC Data Source Administrator dialog closes and the System Data
Source Name is defined.

Task: define the database in Partner Manager

Partner Manager Utilities include an option for defining multiple Trading Manager
databases such as Test, Development and Production.

To define a Trading Manager database:

1. Start Partner Manager. From the Start menu, select Programs > IBM
WebSphere Transformation Extender n.n > Trading Manager > Partner
Manager .

N

Click on the Utilities icon in the Partner Manager tool bar.

w

On the Utilities navigator, click Database Settings. The Partner Manager
Database Selection dialog appears.

Select Microsoft Access from Database Vendor drop-down list as shown below.
Select TradingManagerTutorial from the DSN drop-down menu.
Click OK.

Partner Manager will restart to activate the new database.

N oo~

Tutorial exercise 2: defining trading partners

4

In this exercise you will demonstrate your understanding of the Address Book by
defining an internal and external Trading Partner Address Book entry and
corresponding Application Partners. You will:

* View the file edi850inmi.edi and verify that the information for the Internal and
External Trading Partners matches the data tables shown in the tasks.

* Define an Internal Trading Partner and Application Partner.

* Define an External Trading Partner and Application Partner.
The edi850inmi.edi file is required for this exercise. This test data file is located in:
C:\install_dir\tmgr_vn.n\tutorial \exercises\data

More information about this file is provided in the following section.

Task: analyze the EDI file

Using a text editor such as Windows Notepad, view the file edi850inmi.edi and
confirm internal partner IDs, qualifiers, ISA and GS addresses, interchange control
version ID, element separators (*) and terminators (NL) required for setup.

The edi850inmi.edi file with Partner Manager values for an External Partner
Address Book entry is shown as follows:

IBM WebSphere Transformation Extender: Trading Manager Tutorial



1. Open Partner Manager.

Task: define an internal trading partner

2. From the Address Book navigator, select Internal » X12.

The Address Book for Internal X12 window opens.

3. Click Add.

The Add X12 Trading/Application Partner window opens.

4. Refer to the following table to enter information for My Internal Company into
the Add X12 Trading/Application Partner In Internal Folder X12 window.

In Field...

Enter...

Trading Partner tab:

Trading Partner Name

My Internal Company

ISA Address

12—phone (telephone companies)

Interchange ID

9395100193

ISA Options tab:

Interchange Control Version ID

00306 — Draft Standards for Trial Use
Approved for Publication by ASC X12
Procedures Review board through oc

Interchange Standards ID

U - U.S. EDI Community of ASC X12, TDCC,
and UCS

Authorized Qualifier

00 — No Authorization Info. Present (No
Meaningful Info. In 102)

Authorization ID

Security Qualifier

00 — No Security Info. Present (No
Meaningful Info. In 1040

Password

Separators Box

Element 2A

Sub Element 3E >

Segment Terminator 0D 0A CR/LF
Application Partner tab:

Application Partner Name Sales

GS Address 3959910033

Alias Name

User Defined 1

User Defined 2

For values not shown, accept the default values.
5. Click Save. The Address Book will display the entry.

6. Close the Address Book window.

Task: analyze the EDI file

Using a text editor such as Windows Notepad, view the file edi850inmi.edi and
confirm external partner IDs, qualifiers, ISA and GS addresses, interchange control
version ID, element separators (*) and terminators (NL) required for setup.
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Task: define an external trading partner
1. From the Address Book navigator, select External » X12.
The Address Book for External X12 window opens.
2. Click the Add button.
The Add X12 Trading/Application Partner window opens.

3. Refer to the following table to enter information for Johnson Office Supplies
into the Add X12 Trading/Application Partner in External Folder X12 window.

Note: For values not shown, accept the default values.

In Field... Enter...

Trading Partner tab:

Trading Partner Name Johnson Office Supplies

ISA Address 12 — phone (telephone companies)
Interchange ID 8473179000

ISA Options tab:

Interchange Control Version ID 00306 — Draft Standards for Trial Use

Approved for Publication by ASC X12
Procedures Review Board through oc

Interchange Standards ID U - U.S. EDI Community of ASC X12,
TDCC, and UCS
Authorization Qualifier 00 — No Authorization Info. Present (No

Meaningful Info. In 102)

Authorization ID

Security Qualifier 00 — No Security Info. Present (No
Meaningful Info. In 104)

Password

Separators Box

Element 2A*

Sub Element 3E >

Segment Terminator 0D 0A CR/LF
Application Partner tab:

Application Partner Name Purchasing
GS Address 006250740
Alias Name

User Defined 1

User Defined 2

4. Click Save.

The information that you have entered is displayed in the Address Book for
External X12 window.

5. Close the Address Book for External X12 window.

6 IBM WebSphere Transformation Extender: Trading Manager Tutorial



Task: define an administrative contact for an external trading

partner

The definition for the external trading partner, Johnson Office Supplies, needs to
include some contact information.

1.

In the Address Book for External X12 window, select Johnson Office Supplies.

2. Click Contacts. The Contacts for Johnson Office Supplies window is displayed.

3. Click Add.
The Add a Contact for Johnson Office Supplies window opens.

4. Refer to the following table to add contact information into the Add A Contact
for Johnson Office Supplies window.

In Field... Enter...

Last Name Jordan

First Name William

Phone 555-555-1000

5. Click Save.
The contact information is now displayed in the Contacts for Johnson Office
Supplies window.

6. Close the Contacts window and the Address Book for X12 External window.

Tutorial exercise 3: defining post offices

In this exercise you will demonstrate your understanding of Post Offices by
defining several Get and Put File Post Offices. You will:

Define the File Get Post Office where EDI data will be retrieved for processing.

Define the File Put Post Office where EDI data will routed for processing by an
external application.

Define the File Put Post Office where Functional Acknowledgments (997) will be
routed for transmission.

Task: add a file get post office

1. Click Post Offices from Partner Manager toolbar.

2. Select All Post Offices.

3. Click Add.
The Add Post Office window opens.

4. Enter the information in the following table into the fields in the Add Post
Office (Get Post Office) window:

In field... Enter...

Name EDI data ready for processing

Nickname EDI

Adapter Type File

Get/Put indicator Get Post Office

Directory install_dir\tmgr_vn.n\mmgr\mail

5. Click Save to save the information.
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The Add Post Office window closes and the information that you entered is
displayed in the All Post Offices window as shown:

6. Close the All Post Offices window.

Task: add a file put post office
1. Click Post Offices in the Partner Manager toolbar.
2. Select All Post Offices.
3. Click Add.
The Add Post Office window opens.

4. Enter the information in the following table into the fields in the Add Post
Office (Put Post Office) window:

In Field... Enter...

Name EDI data ready for App Map

Nickname APP

Adapter Type File

Get/Put Indicator Put Post Office

Directory install_dir\tmgr_vn.n\tutorial \exercises\myfiles\in\
app850in

5. Save your changes.
The Put Post Office will be listed in the All Post Offices list box.

Task: add another put post office
1. Click Post Offices in the Partner Manager toolbar.
2. Select All Post Offices.
3. Click Add.
The Add Post Office window opens.

4. Enter the information in the following table into the fields in the Add Post
Office (Put Post Office) window:

In Field... Enter...

Name externalapp data ready to send

Nickname XAP

Adapter Type File

Get/Put Indicator Put Post Office

Directory install_dir\tmgr_vn.n\tutorial \exercises\myfiles\out\
externalapp

5. Save your changes.
The Put Post Office will be listed in the All Post Offices list box.

Tutorial exercise 4: defining inbound trade links

In this exercise you will learn how to define an Inbound Trade Link.

8 1BM WebSphere Transformation Extender: Trading Manager Tutorial



In the following tasks, the External Trading Partner, Johnson Office Supplies, will
be sending ANSI 850 Purchase Orders to an Internal Trading Partner called "My
Internal Company”. Johnson Office Supplies requires that the Internal Trading
Partner, My Internal Company, send them a 997 Functional Acknowledgement.

Task: define the trade link

1.

Click Trade Links in the Partner Manager tool bar.

2. Select Inbound ~» X12.

The X12 Inbound Trade Links window opens.

3. In the X12 Inbound Trade Links window click Add Link. This will open the
X12 Inbound Trade Links Add Wizard.

4. Select the External Trading Partner (the “from’ partner) by clicking Find All.
This will open up the X12 Folder Look up In Dialog.

5. Choose the X12 Johnson Office Supplies Purchasing line and click Select.

6. Click Next. Select the Internal Trading Partner (the “to” partner) by clicking
Find All. This will open up the X12 Partner Lookup in Folder: Internal
dialog.

7. Choose the X12 My Internal Company Sales line and click Select.

8. Click Next. Select the Get Post Office for the trade link from the drop down
list.

9. The Edi data ready for Processing should be the only available selection. Click
Next.

10. Click Finish. The X12 Trade Link: Add Applicationdialog will open. Enter
3060 for the Version, and select PO Purchase Order (850) for the Functional
ID.

11. Click OK. The X12 Inbound Trade Links dialog will open. Use the table below
to update:

In Field... Enter...

Trade Link:

External Trading Partner Johnson Trading Supplies

Internal Trading Partner My Internal Company

Get Post Office EDI data ready for Processing

Post Offices/Routing;:

Test and/or Production Enable Test Disable Production

Test Put Post Office EDI data ready for App Map

Acknowledgments / Validate By tab:

Ack Level Transaction Set Level

997 Version 3060

Validate By Transaction Set

12. Click Save.

13.

14.

The Automatic Outbound Acknowledgement Creation for Version 3060 dialog
will open.

Select “externalapp data ready to send’ from the Put Post Office drop down
list, and select "Edi data ready for processing’ from the Get Post Office drop
down list. Click Create.

Close the X12 Inbound Trade Links window.
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Tutorial exercise 5: creating trade link type trees

In this exercise you will run the EDI Wizard to generate type trees based on Trade
Link information.

These type trees will be used by the Message Manager system to validate data
against the ANSI X12 standards.

Task: run the EDI wizard
1. Click EDI Wizard on the from the Partner Manager menu bar. The only menu
option available is EDI Wizard.
The EDI Wizard opens.

2. Refer to the following table to specify the paths for the IBM WebSphere
Transformation Extender Design Studio installation and type tree locations:

Remember that install_dir refers to the current install directory of your IBM
WebSphere Transformation Extender software and n.n refers to the current
version of Trading Manager.

In Field... Select...

Directory location of IBM WebSphere install_dir
Transformation Extender software

Directory location of EDI type trees install_dir\tmgr_vn.n\tutorial \exercises\trees

Directory for your new message manager |install_dir\tmgr_vn.n\mmgr
trees

3. Click Next.

The wizard will warn you that you already have an x12mail.mtt tree. This is
the default tree the installation provides.

4. Click OK to update the tree.

The wizard creates the x12mail.mtt from your existing X12 trees. Upon
successful creation the following dialog opens:

5. Click Done, and close Partner Manager.

10 1BM WebSphere Transformation Extender: Trading Manager Tutorial



Chapter 3. Using message manager

This chapter contains the following tutorials that are related to the use of Message
Manager:

"Tutorial Exercise 6: Deploying Message Manager’|

"Tutorial Exercise 7: Configuring System Resources and the Launcher’|

Tutorial exercise 6: deploying message manager

In this exercise you will demonstrate your understanding of the deployment
process by deploying the Message Manager system of maps.

Identify the Trading Manager database
Deploy the Message Manager system maps.
Deploy the Runmaps system of maps.

Task: identify the trading manager database

1.

8.

Open the update.mdq file, located in the install_dir\<tmgr_vn.n\mmgr
directory) in the IBM WebSphere Transformation Extender Database Interface
Designer.

In the navigator, right-click on TmgrMgrDB and select Edit.

The Database Definition dialog opens.

Expand the Adapter setting as shown.

Select ODBC as the Adapter Type and Microsoft Windows as the Platform.

Note: It is recommended that you select a native adapter type where possible.

Under the Data Source options, select TradingManagerTutorial for both
Database Interface Designer and Runtime databases.

The values in the Database Definition dialog appear as shown.
Click OK.

Verify the connection by right-clicking on the database in the Database Interface
Designer Navigator and selecting Generate Type Trees from Tables.

Note: If a list of tables is displayed, the database connection was successfully
established.

Click Close, and then close the Database Interface Designer.

Task: deploy the message manager system

1.

© Copyright IBM Corp. 2006

Start Message Manager by going to the Start Menu and selecting IBM
Transformation Extender n.n | Trading Manager | Message Manager.

In the Navigator click the Composition tab to expand Msg_Mgr.

Select Message Manager system in the Navigator, then from the menu bar,
select System » Deploy ~» Definitions. TheDefine Deploy Scripts for Message
Manager dialog opens.

Ensure that DeployMessageManager is selected and then select Generate and
Transfer Launcher Control File, as shown above.

Click Details.
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6. In the Launcher control file path on server dialog box, verify that the

MessageManager .msl will be saved in IBM Transformation Extender Design
Studio \systems subdirectory.

Run the DeployMessageManager deploy script by selecting Message Manager
system in the Navigator, then from the menu bar, select System » Deploy -
DeployMessageManager.

Verify that the system was deployed successfully.

Note: When you deploy the system, the maps will have warnings. This is
expected behavior.

Task: deploy the RunMaps system
1.
2. Verify that the system was deployed successfully.

Select RunMaps system and run the BuildRunMaps deploy script.

3. Close Msg_Mgr.msd file and save the changes.

Tutorial exercise 7: configuring system resources and the Launcher

12

In this exercise you will demonstrate your understanding of the Resource Registry
and Launcher tools by configuring the Resource Registry to work with the
Message Manager system and monitoring process activity with the Launcher
Monitoring tools.

In this exercise you will:
1.

oo bk~ w

Configure the Resource Registry to create the Resource.mrc file used by
Message Manager to define the Message Manager system to the Resource
Registry.

Configure Launcher Administration and Management Console and start
Launcher Service.

Open Launcher Service Monitor.

Drop test file to trigger the system to run.

Verify data validated and routed in Snapshot Viewer.

Record any errors, your solutions and check corrections

Task: create resource configuration files

1.

Start the Resource Registry from the IBM WebSphere Transformation Extender
Start menu link.

Right-click on Configuration File and select New

Save new Resource Configuration file as Resource.mrc under the
C:\install_dir\<tmgr_vn.n\mmgr\ directory.

Expand Resource.

Right-click on Launcher then select Add.

In the Add New System dialog, click the browse button and select the

MessageManager.msl file located in the deploy directory
C:\install_dir\systems\

Click Select then click OK. Under Launcher you should have a new entry
named MessageManager.

Right-click on MessageManager and select Edit. Click Add in the Edit
Resources dialog.

IBM WebSphere Transformation Extender: Trading Manager Tutorial



10.
1.
12.

1

13.

Browse and select the mmgr.mrn file located in the C:\install_dir\<tmgr_vn.n\
mmgr\ directory and click Select, then click OK.

Right-click on Command Server and select Edit.
Add the mmgr.mrn file to the Command Server.

Using the same technique you used for changing the Command Server
resource, change the Global resource to mmgr.mrn.

Select File » Exit and click Yes to save changes.

Task: configure the IBM WebSphere Transformation Extender
with Launcher
1.

6.
7.

The Launcher Administration application defines the Launcher startup
parameters, valid deployment directories and access privileges. Access the
Launcher Administration by selecting Launcher Administration from theIBM
WebSphere Transformation Extender Start menu link.

On the General tab, disable Automatic Startup to allow the system to be
started manually in the Management Console.

Identify the Resource Configuration file for the Launcher by selecting
Resource.mrc under C:\install_dir\tmgr_vn.n\mmgr\ as the Resource
Configuration File.

On the Deployment Directories tab, ensure that C:\install_dirtmgr_vn.n\
systems (where you deployed the Message Manager system) is specified as a
deployment directory.

Create an account that will allow you to monitor and control the Launcher in
the Access tab by clicking Add then entering a User Name (your name), Login
Name (your initials), and Password (letmein)

Change the Access Rights from Revoke to Grant for all actions.
Click OK to exit out of the Launcher Administration tool.

Task: define the IBM WebSphere Transformation Extender with
Launcher in the management cConsole

The IBM WebSphere Transformation Extender Management Console controls and
monitors Launcher systems.

1.

o o s W N

Start the Management Console by selecting Management Console from the
IBM WebSphere Transformation Extender Start menu link or the IBM
WebSphere Transformation Extender Design Studio Start menu link.

Select Launcher » New.

Enter a server Name of MessageManager.

Enter the Launcher Host Name of localhost.

Enter User Name (your initials) and Password (letmein).

Click OK. The MessageManager system will now appear in the console
window. Leave the Management Console open and continue.

Task: run the IBM WebSphere Transformation Extender with
Launcher

1.

Start the Launcher service in the Windows Services, which can be accessed
through the Windows Control Panel.

The Launcher Monitor will allow you to monitor the Message Manager
system graphically. Access the Launcher Monitor by selecting by selecting

Chapter 3. Using message manager 13



Launcher Monitor from the IBM WebSphere Transformation Extender Start
menu link or the IBM WebSphere Transformation Extender Design Studio
Start menu link.

Select Options » Select Launcher and click Add to add a new server.
Enter the Launcher Name as MessageManager.

Enter User Login (your initials) and Password (letmein).

Enter LocalHost for Server.

Click Connect.

Select the Message Manager system then click OK and click OK again.

©®NO O H

In the Management Console, right-click the MessageManager Launcher and
select Connect.

10. Right-click CompoundSystem and select Start.

11. The Export map will run as soon as the Launcher is started. Check the
Management Console to verify it completed successfully before proceeding to

the next step. There will be 2 completed maps under History Successes, and
the History Total will also be 2.

12. The first time that you run the event server, you will receive a History
Function Failure. This is because the export map is looking for a non-existent
backup file in the mmgr\share directory. The second and subsequent times
the event server is launched, this error will not repeat. To test this, stop the
event server and restart it by right clicking on the CompoundSystem icon,
selecting Stop, then right click again and select Start.

Task: drop the test file

1. Copy the file Edi850inMI.EDI (located in: C:\install_dir\tmgr_vn.n\tutorial\
exercises\data)
to the
C:\install_dir\tmgr_vn.n\ mmgr\mail subdirectory.

The appearance of this file should trigger the system to start.

2. Click the Snapshot button in the Launcher Monitor as the activity begins to
create a snapshot (.mss file).

Task: verify that data was validated and routed in Snapshot
Viewer

The IBM WebSphere Transformation Extender Snapshot Viewer allows you to view
the snapshots of Launcher activity taken in the Launcher Monitor. Snapshots are
saved in the IBM WebSphere Transformation Extender install directory as .mss file.

1. Start the Snapshot Viewer, by se lecting by selecting Snapshot Viewer from the
IBM WebSphere Transformation Extender with Launcher Start menu link or
the IBM WebSphere Transformation Extender Design Studio Start menu link

2. The snapshot file name is the date and time the snapshot was taken. Open the
snapshot you just created.

3. Right-click on the map time lines to view the detailed processing information.

Task: record any errors and your solutions and check
corrections

A validated 850 PO and 997 Ack should appear in the Put Post Office locations
you specified in the Partner Manager exercise.
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. If necessary, making any corrections and re-run the system until it completes
successfully.

. When successful, delete *.app file from Put Directory location of
C:\install_dir\tmgr_vn.n\tutorial \exercises\myfiles\In\app850in.
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Chapter 4. Integrating external systems

This chapter contains the following tutorials that are related to integrating external
systems:

« ['Tutorial Exercise 8: Deploying an Inbound Application System']

* |"Tutorial Exercise 9: Deploying an Outbound Application System”|

Tutorial exercise 8: deploying an inbound application system

Your company (My Internal Company) is using Trading Manager and all its
components to begin e-commerce activity with an additional trading partner Acme
Corp. Follow the exercises to setup and begin this e-commerce activity with this
new Partner.

You have already set up My Internal Company as the internal X12 trading partner.
All you need to do is set up Acme Corp as an X12 external trading partner.

To your test database, Acme Corp will begin sending purchase orders (850). You
will also need to define an AppMap system to handle processing of the Purchase
Orders.The AppMap EDI850IN is provided.

In this exercise you will:

* Setup Acme Corp as a new trading partner in Partner Manager

* Deploy Message Manager and an inbound application system (Purchase Order)
* Deploy outbound application system (Invoice)

* Modify the system trigger

¢ Deploy and test the system

Assumptions

The following files are required to complete this exercise.

It should be noted thatPO850mi.DAT
is an input data file located in the following directory :
C:\install_dir\tmgr_vn.n\tutorial\
exercises\data
* EDI850IN.mms
An application map source file located in the following directory :
C:\install_dir\tmgr_vn.n\tutorial \exercises\maps
* App810ot.mms
A source map used to convert data for an outbound invoice is located in the
following directory :
C:\install_dir\tmgr_vn.n\tutorial \exercises\maps

Task: Define a new external trading partner

1. Using a text editor such as Microsoft Notepad open the data file PO850mi.DAT
to confirm partner IDs, element separators(*) and terminators (NL) required for
the setup.

© Copyright IBM Corp. 2006 17



Review the information in the following Trading Partner Information table

about the External Trading Partner, Acme Corp.

3. Referring to the table on the next page, define an External Trading Partner
Address Book entry.

In Field... | Enter...

Trading Partner Tab:

Trading Partner Name: ACME Corp.

ISA Address: Z7 - Mutually Defined

Interchange ID: ACMECORP

ISA Options Tab:

Interchange Control Version ID:

00306 - Draft Standards for Trial Use
Approved for Publication by ASC X12
Procedures Review Board through oc

Interchange Standards ID:

U - U.S. EDI Community of ASC X12,
TDCC, and UCS

Authorization Qualifier:

00 - No Authorization Info. Present (No
Meaningful Info. In 102)

Authorization ID:

Security Qualifier:

00 - No Security Info. Present (No
Meaningful Info. In 104)

Password

Separators Box

Element 2A*

Sub Element 3E >

Segment Terminator 0D 0A CR/LF
Application Partner tab:

Application Partner Name PURCHASING
GS Address ACMECORP

Task: define a get post office

Referring to the following information, define a new GET Post Office.

Add Post Office

(Get Post Office)

Name: PO data ready for Processing
Nickname DAT
Adapter Type File

Get /Put Indicator

<tmgr directory>\mmgr\mail

Task: define a trade link and select acknowledgement level

Referring to the information below, define an Inbound Trade Link to "My Internal
Company” from "ACME Corp”.

Add Trade Link | (Inbound)
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From Trading/Application Partner:

ACME Corp.

To Trading/Application Partner:

My Internal Company

Get Post Office:

PO data ready for Processing

Version:

3060

Functional ID:

PO Purchase Order (850)

Post Offices/Routing tab:

Test/Production Indicators:

Enable Test; Disable Production

Test Post Office

EDI data ready for App Map

Acknowledgements/Validate By Tab:

Ack Level:

Transaction Set

Validate By:

Transaction Set

997 Version:

3060

(Automatic Outbound Assistant)

Put Post Office (FA)

externalapp data ready to send

Get Post Office (FA)

PO data ready for processing

Task: define an application subsystem

In this task you will define an application subsystem to take the inbound purchase
order and transform it so it can be processed by your internal purchasing

application.

Use the EDIS50IN.mms map to convert the data in the subsystem. You want this

map to execute based on the arrival of data in the Put Post Office directory that
you defined for Acme Corp. with an extension of *.app

1.
2.

Start the Integration Flow Designer and open a new system definition file.
Save the new system definition file in C:\install_dir\tmgr_vn.n\tutorial \
exercises\myfiles as AppMap.

Rename System1 to Inbound.

Add the map in the EDI850IN.mms source map to the Inbound system.
Right click on the EDI850IN map in the Inbound system and select Edit

Launcher Settings to set the input trigger and override the source and
destination file paths as follows:

e Input card
Source Event is On
Source file: C:\install_dir\tmgr_vn.n\tutorial \exercises\myfiles\in
\app850in\*.app

¢ Output card #1
Target file: C:\'V\tutorial \exercises\myfiles\in\app850in\*.ord

e Output card #2
Target file: C:\install_dir\tmgr_vn.n\tutorial \exercises\myfiles\in\
app850in\*.lin

Change the from the Server drop-down list to Local Server.

Create a deploy script named as Inbound with C:\install_dir\systems
directory as the deploy directory.

Note: Select option Build and Transfer Maps as well.
Deploy the Inbound system.
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9.
10.

Save the changes to the system definition file.
Verify that all *.app files were deleted from the directory:

C:\install_dir\tmgr_vn.n\tutorial \exercises\MyFiles\In\app850in

Task: restart the Launcher and run the system

ok wbh=

N o

10.

11.

In the Management Console, stop the CompoundSystem.
Right-click on MessageManager and select Disconnect.
Stop then start the Launcher service.

Start the Launcher Monitor and select the Launcher.

Open the Management Console and connect to the Launcher (configured in a
previous exercise).
Start the CompoundSystem.

Using Windows Explorer, copy the data file PO850mi.DAT in
C:\install_dir\tmgr_vn.n\tutorial \

exercises\Data to the C:\install_dir\\tmgr\mmgr\mail directory.
This file is the trigger for the Message Manager system

Take a snapshot of the system in the Launcher Monitor and verify the maps
completed successfully.

A validated 850 PO and 997 Ack should appear in the Put Post Office
locations:

C:\install_dir\tmgr_vn.n\tutorial \exercises\MyFiles\In\app850in\*.appand
C:\install_dir\tmgr_vn.n\tutorial \exercises\MyFiles\ Out\externalapp \*.xap

Upon successful completion delete all files under:
C:\install_dir\tmgr_vn.n\tutorial \exercises\MyFiles\In\ App850in\.

In the Management Console, stop the CompoundSystem and disconnect from
MessageManager.

Stop the Launcher service.

Tutorial exercise 9: deploying an outbound application system

20

Now that the inbound application system is completed and tested, you must
deploy an outbound application system that takes the inbound Purchase Order
(850) created in the Message Manager exercise and formats an outbound Invoice
(810). The system will be executed based on triggers.

Use the App810ot.mms map for your outbound system.

In this exercise you will:

* Use Partner Manager to:

— Define a new application for My Internal Company and Acme Corp
— Define PUT Post Office
— Define an outbound TradeLink

* Use the Integration Flow Designer to:

— Define outbound application system

— Define wild card input triggers and wild card output file names

— Deploy outbound system
* Use the IBM WebSphere Transformation Extender to:
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— Run the system with the Launcher

— Monitor the system using the Management Console and Launcher Monitor

Files for this exercise:

PO850mi.dat
Data file located in C:\install_dir\tmgr_vn.n\tutorial \exercises\data

App810ot.mms
Map source file located in C:\install_dir\tmgr_vn.n\tutorial \exercises\maps

EDI type trees (trimmed for class)
Type trees required by EDI Wizard located in the C:\install_dir\tmgr_vn.n\
tutorial \exercises\trees

itemref.txt
Input file for App810ot.mms located in C:\install_dir\tmgr_vn.n\tutorial\
exercises\data

profile2.txt
Input file for App810ot.mms located in C:\install_dir\tmgr_vn.n\tutorial\
exercises\data

Task: define the application partner

1.

2.
3.
4.

5.
6.

For internal Trading Partner My Internal Company enter a new Application
Partner as follows:

Application Partner Name: Invoice
GS Address: 3959910032

For external Trading Partner Acme Corp enter a new application Partner as
follows:

Application Partner Name: Invoice
GS Address: ACMECO

Task: define a post office for outgoing invoice

Referring to the following information, define a new PUT Post Office.

* PO Name: Invoices ready to send
e PO Nickname: INV
* Adapter Type: File

* PO Path C:\install_dir\tmgr_vn.n\tutorial\exercises\myfiles\out\app810out

Task: define a new trade link for the outgoing 810

Referring to the information below, define an Outbound Trade Link from "My
Internal Company” to "Acme".

Add Trade Link | (Outbound)
From Trading/Application Partner:

Trading Partner ACME Corp.
Application Partner Invoice

To Trading/Application Partner:

Trading Partner My Internal Company

Application Partner Invoice
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Get Post Office EDI data ready for Processing
Interchange Control# Scheme Increment

Group Control# Scheme Relative

Version 3060

Functional ID IN Invoice Information (810, 819)
PO/Validation/Ack:

Put Post Office | Invoices ready to send

Task: run EDI type tree wizard

Refer to Exercise 5: Creating Trade Link Type Trees exercise if you require step by
step instructions.

Task: deploy message manager system and RunMaps system

Refer to Message Manager Exercise 6 - Task: Deploy the Message Manager System
if you require step by step instructions.

Task: define new application map in the AppMap system

1.

Open the AppMap system definition file that was created in the task titled:
['Task: Define an application subsystem’|.

Rename System1 to Outbound.

Add the source map App810ot.mms located in C:\install_dir\tmgr_vn.n\
tutorial\exercises\maps\ to this system.

Click the Launcher Settings button on App810ot and set the input trigger and
override the destination file paths as follows:

* Input card #1: Source Event ON
Source file:
C:\install_dir\tmgr_vn.n\tutorial \exercises \myfiles\In\ App850in\*.ord

* Input card #2: Source Event ON
Source file: C:\install_dir\tmgr_vn.n\tutorial \exercises\myfiles\In\
App850in\*.lin

* Input card #3:
Source file: C:\install_dir\tmgr_vn.n\tutorial \exercises\data\
ITEMXREETXT

* Input card #4:
Source file: C:\install_dir\tmgr_vn.n\tutorial \exercises\data\profile2.txt

¢ Output card#1:
Target file: C:\install_dir\tmgr_vn.n\mmgr\mail\*mo.edi

* Output card #2:
Target file: C C:\install_dir\tmgr_vn.n\tutorial \exercises\data\ profile2.txt

Change Server to Local Server.

Create a deploy script for the Outbound system that deploys the Launcher file
(.msl) to the IBM WebSphere Transformation Extender\systems directory.

Deploy the Outbound system.
Save your changes.
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Task: start the Launcher and monitor the system

1.
2.
3.

Start Launcher service.
Start the Launcher Monitor and connect to the Launcher.

Open the Management Console and Connect to the Launcher and start the
CompoundSystem.

Using Windows Explorer, locate data file PO850mi.DAT in
C:\install_dir\tmgr_vn.n\tutorial \exercises\data\. Copy PO850mi.DAT to the
install_dir\tmgr_vn.n\mmgr\mail directory.

The appearance of this file in the directory will trigger the Message Manager
system. The files produced by Message Manager will trigger the AppMap
Inbound system.

Record any errors and your solutions and check corrections

Take a snapshot of the system in the Launcher Monitor and verify the maps
completed successfully.

A validated 850 PO, 810 INV and 997 Ack should appear in the Put Post Office
locations you specified in the Partner Manager exercise.

After making any corrections to the dropped test file and running Launcher to
verify success, delete all files under C:\install_dir\tmgr_vn.n\tutorial\
exercises\myfiles\In\ App850in\.

In the Management Console, stop the CompoundSystem and disconnect from
the Launcher.

Stop the Launcher service.
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Chapter 5. Partner Manager monitoring

This chapter contains the following tutorials that are related to the monitoring of
Partner Manager :

« |'Tutorial Exercise 10: Running Traffic Reports'|

e |"Tutorial Exercise 11: Running Additional Reports”l

Tutorial exercise 10: running traffic reports

In this exercise you will demonstrate your understanding of monitoring traffic
activity by running and exporting a transmission level report for previously
processed e-commerce data.

In this exercise you will:

* Run a report for previous exercise activity.

* Select Display Detail option to view transmission detail.

* Select Report Info option to view report detail

¢ Select drilldown option to query the details of the transmission.
* Make note of any errors

* Export a traffic report

Task: run inbound transmission traffic report
1. Click on Reports in the Partner Manager toolbar.

2. Create a Traffic report that will report Inbound Transmissions for All Dates
The Inbound Transmission Report View panel should be displayed.

3. Right-click on a transmission entry and select Display Detail to review
transmission detail information.

4. Click Close.

5. Right-click on a transmission entry and select Report Info. Review Report
Detail Information.

Task: display transmission detail

1. Right-click on a transmission entry and select Drilldown. Review displayed
transmission information.

2. Right-click on a transmission entry and select Drilldown. Review displayed
interchange information.

3. Right-click on an interchange entry and select Drilldown. Review displayed
Functional Group information.

4. Right-click on functional group entry and select Drilldown. Review displayed
Transaction Set information.

5. Right-click on a transaction set entry and select Display Detail. Review
transaction set detail information.

6. Click Back.
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Task: export transaction set detail report

1. Right-click on a transaction set entry and select Export in the Traffic Report
Export dialog.

2. In the Traffic Report Export dialog, click Browse for export file name.

3. Save the file to: C:\install_dir\tmgr_vn.n\tutorial\exercises\myfiles\ (where
n.n indicates current version number), and accept the default file name. Click
Open. The file name and location appear in the Export File Name field.

4. Click Begin Export. Your Internet browser is automatically launched.

5. Review the exported report.

Tutorial exercise 11: running additional reports

In this exercise you will demonstrate your understanding of reviewing Trading
Partner setup information by running, reviewing, printing and Trading Partner
information.

In this exercise you will:

* Run an Additional Report

¢ Review Additional Report information
* Print Additional Report

* Export Additional Report

Task: run inbound trade link report

1. Click on Reports in the Partner Manager toolbar. The Reports navigator
appears.

2. Select Report Type: Additional Reports
3. Select Report: X12 Trade Link Inbound Application

4. Click Run Report. The X12 Trade Link Inbound Application Report panel
appears.

5. Accept the report default run parameters, click Run Report.
6. Review report information.

Task: export additional report
1. Click the Export icon within Report Viewer.
* Select location: C:\install_dir\tmgr_vn.n\tutorial \exercises\myfiles\
¢ Enter File name: X12_Inbound_Links
* File Type: HTML
2. In the Traffic Report Export dialog, click Browse for export file name.

3. Save the file to: C:\install_dir\tmgr_vn.n\tutorial\exercises\myfiles\ (where
n.n indicates current version number), and accept the default file name. Click
Open. The file name and location appear in the Export File Name field.

4. Click Begin Export. Your Internet browser is automatically launched.
5. Review the exported report.

Task: Print additional report

1. In the browser window, select File > Print.
2. Review the report.
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Chapter 6. Trading Manager maintenance

This chapter contains the following tutorials that are related to the maintenance of
Trading Manager:

* |'Tutorial Exercise 12: Copying the Partner Manager Database’|

» |'Tutorial Exercise 13: Security Setup’|

Tutorial exercise 12: copying the Partner Manager database

In exercise you will demonstrate your understanding of Partner Manager database
utilities by using the Database Copy utility to create a copy of the current Partner
Manager database.

Task: create DSN for empty database

1. Using Windows Explorer, browse to the C:\install_dir\<tmgr_vn.n\pmgr
directory.

2. Copy m4EC_empty.mdb to your working directory (C:\install_dir\<tmgr_vn.n\
tutorial\exercises\myfiles) as CM_Test.mdb.

3. Start the Data Sources (ODBC) application from the Windows Administrative
Tools menu.

4. On the System DSN tab, click Add.
5. Select Microsoft Access Driver (*.mdb) and click Finish.

6. Enter a Data Source Name of CM_DB_TEST and a description of
CM_DB_TEST Database

7. Click Select. The Select Database Dialog appears.

8. Browse to C:\install_dir\<tmgr_vn.n\tutorial\exercises\myfiles and select
CM_test.mdb

9. Click OK to save the changes and click OK again to exit the ODBC Data
Sources application

Task: copy Partner Manager database

1. Start the Partner Manager Database Copy utility from the start menu.

2. Select the DSN of the database you are currently using
(CommerceManagerTutorial)

Select Source Database Vendor: Microsoft Access.
Select the new DSN you created in the previous task as the Destination DSN.
Select Destination Database Vendor: Microsoft Access.

o o A~ W

Click Begin Copy.

Tutorial exercise 13: security setup

In exercise you will demonstrate your understanding of Partner Security by setting
secure access to Partner Manager.

In this exercise you will:
¢ Define a security group.
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¢ Create a User ID.
* Restart Partner Manager and sign-on with a User ID.

Task: create security group

1. Select Security Groups from the Utilities navigator. The Group Information
panel appears.

Enter Security Groups Name of EDI Admin and press ENTER.
Click Yes to create.

Select Security Profile of Administrator.

Disable the EDI Wizard option.

Save the Security Group.

ook

Task: create user ID and assign to security group
1. Select User Maintenance from the Utilities navigator.
2. Click Add.
The User Maintenance: Add dialog opens.
Enter your user information in the User ID and User Name fields.
In the Group ID drop down menu, select EDI Admin.
Enter a Password .
Enable Password Expires Every and enter 30 days.

N oo~ o

Save the new user account.

Task: restart Partner Manager and log on

1. Restart Partner Manager.
2. Enter the User ID and Password you created in the previous task to logon.
3. Verify that the EDI Wizard option is now grayed out.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

577 Airport Blvd., Suite 800
Burlingame, CA 94010
US.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.
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Programming interface information

Programming interface information, if provided, is intended to help you create
application software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.

However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks and service marks

The following terms are trademarks or registered trademarks of International
Business Machines Corporation in the United States or other countries, or both:

AIX

AIX 5L

AS/400

Ascential

Ascential DataStage
Ascential Enterprise Integration Suite
Ascential QualityStage
Ascential RTI
Ascential Software
Ascential

CICS

DataStage

DB2

DB2 Universal Database
developerWorks
Footprint
Hiperspace

IBM

the IBM logo
ibm.com

IMS

Informix

Lotus

Lotus Notes
MQSeries

MVS

0S5/390

0S/400

Passport Advantage
Redbooks

RISC System /6000
Roma

S/390

System z

Trading Partner
Tivoli
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WebSphere
z/ Architecture
z/0S

zSeries

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Other company, product, or service names may be trademarks or service marks of
others.

This product includes software developed by the Eclipse Project
(http:/ /www.eclipse.org/).

JAVA
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